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CÂU HỎI LÝ THUYẾT PHẦN KIẾN THỨC CƠ BẢN MÁY TÍNH 
 
1. 1 KB bằng: 

a. 1204 byte   b. 1024 byte   c. 1024 bit   d. 1240 byte  
 
2. Bộ nhớ ngoài của máy tính thường là: 

a. Đĩa cứng, ROM, đĩa CD, thiết bị nhớ Flash (USB). 
b. Đĩa CD, đĩa cứng, ROM, RAM  
c. Đĩa mềm, đĩa CD, RAM, đĩa cứng  
d. Các câu trên đều sai. 

 
3. Chữ viết tắt MB thường được đề cập trong hệ thống tin học dùng để đo: 
 a. Tốc độ xử lý    b. Khả năng lưu trữ     
 c. Mức độ âm thanh  d. Không đo gì  
 
4. Nhóm thiết bị ra: 

a.Màn hình, máy in, chuột, máy quét  
b. Máy in, loa, bàn phím, màn hình  
c. Màn hình, loa, tai nghe, máy chiếu   
d. Máy in, máy chiếu, bàn phím, loa  

 
5. Chọn phát biểu đúng: 

a. RAM là Random Access Memory   
b. ROM là Random Only Memory  
c. RAM là bộ nhớ chỉ đọc  
d. ROM là bộ nhớ truy cập ngẫu nhiên  

 
6. Con số 400 GB trong hệ thống máy tính có thể là: 

a. Tốc độ xử lý của CPU  
b. Tốc độ xử lý của đĩa cứng  
c. Đĩa cứng có dung lượng 400 GB   
d. ý a,b hoặc c đều đúng  

 
7. Phát biểu nào sau đây về RAM là đúng 

a. RAM có thể đọc và ghi dữ liệu   
b. RAM có dung lượng lớn hơn đĩa cứng 
c. RAM có chức năng giống như ROM   
d. RAM chỉ cho phép đọc dữ liệu 

 
8. CPU là: 

a. Mạch điện tử nhỏ bé của máy tính   
b. Phần mềm quyết định các bước thao tác của máy tính 
c. Central Processing Unit   
d. Control Processing Unit. 

 
9. Nhóm thiết bị vào: 

a. Bàn phím, máy quét, máy chiếu; Webcam   
b. Chuột, bàn phím, Webcam, máy quét 
c. Máy quét, tai nghe, bàn phím, micrô   
d. Webcam, micrô, loa, bàn phím. 
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10. Chọn thứ tự tăng dần khi sắp xếp các đơn vị đo thông tin: 

a. KB, GB, MB, TB   b. MB, TB, GB, KB 
c. KB, MB, GB, TB     d. TB, GB, MB, KB 

 
11. Chọn thứ tự giảm dần khi sắp xếp các đơn vị đo thông tin: 

a. Gigabyte, Megabyte, Kilobyte  b. Megabyte, Gigabyte, Kilobyte 
c. Gigabyte, Kilobyte, Megabyte  d. Kilobyte, Megabyte, Gigabyte 

 
12. Đơn vị đo tốc độ xử lí của CPU là  : 

a. MB (Megabyte).   b.  GB (Gigabyte). 
c. KB (Kilobyte).     d. MHz (Megahertz) hoặc GHz (Gigahertz).  

 
 
13. Phím nào sau đây thường được sử dụng cùng lúc với các phím khác để thực hiện một chức năng 
nào đó 

a. Phím Alt    b. Phím Caps Lock   
c. Phím Insert    d. Phím Tab 
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TRẮC NGHIỆM WINDOWS 
 
14. Chọn phát biểu đúng. Trong Windows Explorer: 
 a. Tạo được Shortcut trong cửa sổ  Explore. 
 b. Tạo được Shortcut trên màn hình desktop. 
 c. Tạo được Shortcut trong cửa sổ  Explore và trên màn hình desktop. 
 d. Các câu trên đều đúng.   
 
15. Muốn xóa chương trình trong Windows, ta thực hiện: 
 a. Control Panel và Double Click  tại biểu tượng Add Remove Hardward 
 b. Control Panel và Double Click  tại biểu tượng Add Remove Programs.   
 c. Xoá biểu tượng trên màn hình Desktop 
 d. Các câu trên đều sai 
 
16. Muốn thay đổi dạng số trong Windows ta vào: 
 a. Control Panel và Double Click tại biểu tượng Date/Time. 
 b. Control Panel và Double Click tại biểu tượng Regional Settings.   
 c. Control Panel và Double Click tại biểu tượng Fonts. 
 d. Control Panel và Double Click tại biểu tượng System. 
 
17. Trong Windows Explore hiển thị tập tin dạng chi tiết(có ngày, giờ, kiểu.: 
 a.View/List. b. View/Details.   
 c.View/Small Icons. d. View/Large Icons. 
 
18. Chọn phát biểu đúng. Trong Windows: 
 a. Không thể đổi tên tập tin có thuộc tính lưu trữ. 
 b. Không thể xóa tập tin có thuộc tính chỉ đọc. 
 c. Không thể thay đổi nội dung của tập tin có thuộc tính chỉ đọc.   
 d. Câu a, b, c sai. 
 
19. Chọn phát biểu đúng. Hệ điều hành Windows là: 

a. Hệ điều hành đa nhiệm b. Hệ điều hành có giao diện đồ họa. 
c. Câu a, b đúng.   d. Câu a, b sai. 

 
20. Nút mang dấu trừ trên thanh tiêu đề có chức năng: 
 a. Phục hồi lại cửa sổ đó. b. Cực tiểu hóa cửa sổ về Taskbar.   
 c. Đóng cửa sổ đó. d. Phóng to cực đại cửa sổ đó. 
 
21.Chọn câu đúng. Hệ điều hành Windows là: 
 a. Hệ điều hành đa nhiệm.   b. Hệ điều hành mã nguồn mở. 
 c. Là hệ điều hành miễn phí. d. Câu a, b sai. 
 
22. Muốn phục hồi các tập tin, thư mục bị xóa trên đĩa cứng, ta thực hiện: 
 a. Mở Windows Explorer, vào File chọn Restore. 
 b. Mở Recycle Bin, chọn các tập tin thư mục muốn phục hồi, vào File chọn Restore.   
 c. Mở Windows Explorer, vào Edit chọn Undo delete. 
 d. Mở Recycle Bin, vào File chọn Restore. 
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23. Thành phần nào không thuộc cửa sổ Windows Explore: 
 a. Thanh tiêu đề. b. Thanh công cụ. 
 c. Thanh trạng thái. d. Con trỏ chuột.   
24. Chọn câu sai. Trong Windows: 
 a. Có thể tạo được thư mục và tập tin trong 1 thư mục. 
 b. Có thể tạo thư mục trong tập tin.   
 c. Không thể thay đổi nội dung của tập tin có thuộc tính chỉ đọc. 
 d. Có thể di chuyển tập tin có thuộc tính lưu trữ. 
25. Trong Windows, tập tin có thuộc tính chỉ đọc (read only). thì không thể : 
 a. Xóa b. Thay đổi nội dung.   
 c. Di chuyển d. Các câu trên đều đúng 
26. Trong Windows Explore để đổi tên thư mục, tập tin được chọn, ta thực hiện : 
 a. Click phải chuột\chọn Rename b. File\Rename 
 c. Nhấn F2 d. Câu a, b, c đúng.   
27. Chương trình nào sau đây có thể dùng để giải nén tập tin, thư mục: 
 a. WinZip b. WinRAR 
 c. Câu a và b đều sai d. Câu a và b đều đúng.   
28.  Trong thư mục A có thể chứa: 
 a. Thư mục GiaiThich và tập tin Giai?thich.txt 
 b. Thư mục ?TaiSao và tập tin TaiSao.txt  
 c. Các câu a và b đều sai.   
 d. Các câu a và b đều đúng 
29. Để tạo thư mục trong Windows, ta thực hiện click phải chuột tại nơi cần tạo, chọn: 
 a. Properties. b. Refresh. 
 c. New\Folder.   d. Câu a, b, c sai. 
30. Trong môi trường Windows ta có thể chạy cùng lúc: 
 a. Hai chương trình. b. Chạy nhiều trình ứng dụng khác nhau.   
 c. Chỉ chạy một chương trình. d. Câu a, b, c sai. 
31. Trong Windows Explore ta có thể tìm kiếm tập tin: 
 a. Theo kích thước . b. Theo ngày tháng tạo lập. 
 c. Theo kiểu tập tin. d. Các câu trên đều đúng.   
32. Trong MS Windows, để xóa hẳn tập tin, thư mục (không bỏ vào Recycle Bin) ta dùng tổ hợp 
phím: 
 a. Ctrl – Delete.  b. Alt – Delete. 
 c. Shift – Delete.   d. Tab – Delete. 
33. Muốn cài thêm font mới trong windows, ta thực hiện: 
 a. Vào Control Panel, tiếp tục tìm và chọn biểu tượng Fonts để thêm.   
 b. Vào Control Panel và chọn biểu tượng Add Remove Programs 
 c. Vào MS Word chọn menu Format\Font. 
 d. Các câu trên đều sai. 
34. Trong Windows, mạng ngang hàng (peer to peer network) còn được gọi là: 

a. Group  b. Domain. 
c. Network d. Workgroup.   

35. Khi lưu tập tin bằng Save As muốn tạo thêm một Folder ta chọn: 
a. Up one Level  b. Look in Favoriter. 
c. Create New Folder.   d. Details. 

36.Trong Windows, để chọn chế độ Screen Saver cho màn hình: 
a. Click phải chuột lên Desktop\chọn Properties\chọn Screen Saver. 
b. Click Start\chọn Settings\Control Panel\Display\Screen Saver. 
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 c. Câu a, b đúng.   
 d. Câu a, b sai. 
37. Trong hệ điều hành Windows để thực hiện chống phân mảnh đĩa, ta thực hiện: 
 a. Disk Cleanup. b. Disk Defragmenter.   
 c. System Restore. d. Câu a, b, c sai. 
38. Trong Windows XP để chọn hình nền cho màn hình: 

a. Click phải chuột lên Desktop\ chọn Properties\Desktop. 
b. Click Start\chọn Settings\Control Panel\Display\Desktop. 

 c. Câu a, b đúng.   
 d. Câu a, b sai. 
39. Trong MS Windows, để định dạng cách nhập ngày tháng sử dụng cho các phần mềm (Excel, 
access...), ta vào: 
 a. Control Panel\Add Hardware. b. Control Panel\Date and Time. 
 c. Control Panel\Display. d. Control Panel\Regional and 
40. Trong Windows XP, muốn khởi động Windows Explorer, ta thực hiện: 
 a. Click phải trên Desktop, chọn Explore  
 b. Click phải chuột trên My Computer\Explore. 
 c. Click phải vào nút Start, chọn Explore.  
 d. Câu b và c đúng.   
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TRẮC NGHIỆM PHẦN MS WORD  
 
 
41. Trong MS Word, ta bỏ dấu tiếng việt không được có thể do: 
 a. Không có chương trình gõ tiếng việt.  b. Chọn kiểu gõ tiếng việt không phù hợp. 
 c. Chọn bảng mã không phù hợp.           d. Các câu a, b, c đúng. 
42. Font đang chọn là Tohoma, ta phải chọn bộ mã nào để có thể gõ được tiếng Việt 
 a. TCVN3                                    b.VNI WINDOW 
 c. UNICODE                                d.UTF-8 
43. Trong Microsoft Word để chọn tất cả văn bản ta thực hiện: 
 a. Ctrl – A.                                 b. Ctrl – C. 
 c. Ctrl – V.                                 d. Ctrl – X. 
44. Để đưa con trỏ văn bản về đầu văn bản hiện hành, ta thực hiện: 
 a. Ctrl + Home.                          b. Ctrl + End 
 c. Home                                     d. End 
45. Trong MS Word để chuyển nhanh sang chữ thường hoặc in hoa, ta sử dụng tổ hợp phím: 
 a. Shift-F2.                                 b. Shift-F3. 
 c. Shift-F4.                                d. Shift-F5. 
46. Chọn nhóm phím dùng trong soạn thảo văn bản để di chuyển con trỏ 
 a. Home, End, PageUp, Page Down  b. Các phím F1  đến F12 
 c. Caps Lock, Num Lock, Scroll  Lock           d. Shift, Alt, Ctrl 
47. Để đưa con trỏ văn bản về cuối dòng hiện hành, ta thực hiện: 
 a. Ctrl + Home     b. Ctrl + End 
 c. Home      d. End. 
48. Trong MS Word, sử dụng phím F12 dùng để: 
 a. Đổi chữ thường thành chữ IN HOA.       b. Phóng to cửa sổ. 
 c. Lưu tài liệu đang soạn thảo với tên khác.            d. Không làm gì cả. 
49. Trong Word, giả sử bạn đã đánh dấu một khối văn bản trong văn bản đang soạn thảo, nếu muốn 
lưu nó vào trong bộ nhớ đệm và không còn thấy nó trên màn hình, chọn lệnh: 
 a. Ctrl + V                              b. Ctrl + C 
 c. Ctrl + X                              d. Ctrl + Z 

 
50. 
Hình sau đây cho biết: 
 
  
 a. Văn bản có 1 trang   b.  Văn bản có 1 trang, trang hiện hành là trang 1 
 c. Không có ý nghĩa gì hết  d.  Văn bản được đánh số trang là 1 
  
 
51. Trong Microsoft Word để chuyển đổi chế độ ghi đè ta gõ phím: 
 a. Ctrl                              b. Alt 
 c. Delete                         d. Insert 
52. Khi cần phục hồi thao tác trước đó ta dùng tổ hợp phím: 
 a. Ctrl + F                      b. Ctrl + E 
 c. Ctrl + S                     d. Ctrl + Z 
53. Trong Word công cụ Justify để căng ký tự (canh lề) theo: 
 a. Lề trái                               b. Lề phải 
 c. Canh giữa                             d. Đều hai biên 
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54.Trong định dạng văn bản, muốn chọn kiểu chữ gạch chân, ta sử dụng phím nóng: 
 a. Ctrl + B                      b. Ctrl + I 
 c. Ctrl + U                     d. Ctrl + A 
 
55. Trong MS Word, tổ hợp phím Ctrl-] dùng để : 
 a. Giảm 1 cỡ chữ.                                 b. Tăng 1 cỡ chữ. 
 c. Tăng 2 cỡ chữ.                                 d. Giảm 2 cỡ chữ. 
56.Trong MS Word tổ hợp phím  Ctrl _Shift _=  dùng để định dạng : 
 a. Chỉ số dưới (hệ số).                         b. Chỉ số trên (số mũ). 
 c. Không làm gì cả                              d. Câu a, b c sai. 
57.Trong MS Word để định dạng Font chữ in đậm, dùng tổ hợp phím: 
 a. Ctrl – B                             b. Alt – B 
 c. Ctrl – I     d. Alt – I 
58.Trong MS Word để làm chữ rỗng ta dùng chức năng: 
 a. Shadow      b. Outline 
 c. Emboss     d. Engrave 
59.Trong Word, muốn chèn vào văn bản các kí tự đặc biệt như µ, α, π... ta chọn: 
 a. Insert/Comment    b. Insert/Footnote 
 c. Insert/Caption     d. Insert/Symbol 
60.Trong MS Word, ta có thể thực hiện được: 
 a. Làm lớn ký tự đầu tiên của Paragraph.   b. Định dạng dòng văn bản. 
 c. Chèn hình ảnh từ tập tin trên đĩa USB.  d. Câu a, b, c đúng. 
61.Trong Microsoft Word để xuống dòng mà không ngắt Paragraph, ta thực hiện: 
 a. Nhấn tổ hợp phím Ctrl-Enter.    b. Nhấn tổ hợp phím Alt-Enter.   
 c. Nhấn tổ hợp phím Shift-Enter.    d. Câu a, b, c sai. 
62.Trong MS Word, chức năng Dropcap dùng để: 
 a. Tạo bảng biểu.                                      b. Đổi chữ thường thành chữ  in hoa. 
 c. Làm lớn ký tự đầu đoạn văn bản.          d. Câu a, b, c sai. 
63. Trong MS Word, biểu tượng Format Painter trên thanh công cụ dùng để: 
 a. Tô nền cho đoạn văn bản.   b. Sao chép định dạng. 
 c. Chèn công cụ vẽ hình.   d. Các câu a, b, c sai. 
64. Trong MS Word để ngắt cột cho đoạn văn bản, ta chọn: 
 a. Vào File\ Break                            b. Vào Edit\ Break  
 c. Vào Format\ Break                     d. Insert\Break  
65. Trong MS Word chức năng Insert\Break\Page break dùng: 
 a. Ngắt cột văn bản                            b. Ngắt dòng văn bản 
 c. Ngắt trang văn bản                        d. Ngắt đoạn văn bản 
66. Trong Word, muốn đánh chỉ số tự động ở đầu dòng cho các đoạn văn bản, ta sử dụng chức năng: 
 a. Format/Paragraph               b. Change Case 
 c. Borders and Shading      d. Bullets and Numbering 
67. Trong Word, muốn đánh số trang tự động , ta chọn : 
 a. Format/Paragraph         b. Format/Page numbers 
 c. Insert/Page numbers      d. Insert/Paragraph 
68. Trong Word, muốn in văn bản đang mở, ta sử dụng phím nóng: 
 a. Ctrl + I            b. Ctrl + P 
 c. Ctrl + O      d. Ctrl + N 
69. Trong Word để  in trang hiện hành của văn bản đang mở thì nhấn nút lệnh Ctrl - P, sau đó chọn 
vùng in là : 
 a. Pages                                   b. Current Page 
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 c. All pages                             d. Câu b và c đúng 
70. Trong Word, muốn thiết lập trang in theo chiều ngang, ta chọn : 
 a. Portrait                                    b. Landscape 
 c.Top                                         d. Bottom 
71. Trong MS Word, bảng biểu có thể : 
 a. Chia một bảng biểu thành hai bảng.                 b. Chia một ô thành hai ô. 
 c. Câu a, b đúng.                                               d. Câu a, b sai. 
72. Trong MS Word, bảng biểu có thể : 
 a. Nhập hai bảng biểu thành một bảng.                 b. Nhập hai ô thành một ô. 
 c. Câu a, b đúng.                                                d. Câu a, b sai. 
73. Trong MS Word để thêm một hàng nối đuôi vào bảng, ta định vị trỏ vào ô cuối cùng rồi gõ phím: 
 a. Insert                                       b.Alt 
 c.Ctlr - Tab                                d. Tab 
74. Trong MS Word, chức năng Merger Cells dùng : 
 a. Nhập các bảng biểu thành một bảng.                 b. Nhập các ô thành một ô. 
 c. Câu a, b đúng.                                                d. Câu a, b sai. 
75. MS Word, chức năng Split Cells dùng : 
 a. Tách một bảng biểu thành nhiều bảng.                 b. Tách một ô thành nhiều ô. 
 c. Câu a, b đúng.                                                 d. Câu a, b sai. 
76. Trong MS Word để chèn hình,  ta chọn: 
 a. Format\Picture     b.Insert\Picture 
 c. Insert\Symbol                                                d.File\Picture 
77. Trong MS Word để tạo chữ nghệ thuật,  ta sử dụng chức năng (hoặc công cụ) liên quan đến: 
 a. Object                                      b. WordArt  
 c. Print                                                  d. Symbol  
78.Trong MS Word chức năng Mail Merge dùng để 
 a. Chèn hình                                                            b.Trộn thư 
 c.Tạo chữ nghệ thuật                                               d.Tạo đồ thị 
 
79. Trong MS Word chức năng nào cho phép chèn ngày giờ vào văn bản 
 a. View/Date and Time    b. Edit/Date and Time 
 c. Format/Date and Time    d. Insert/Date and Time 
80. Trong MS Word, không thể thực hiện được: 
 a. Tính toán.                               b. Vẽ hình. 
 c. Quay phim.             d. E-Mail. 
81. Hãy chọn câu sai 
 a.Trong MS Word không thể tính toán     b. Trong MS Word không thể quay phim 
 c. Trong MS Word có thể vẽ hình  d. Trong MS Word có thể sử dụng E-mail 
82. Hãy chọn câu sai 
 a.Ctrl-O: Mở tài liệu    b. Ctrl-N : Mở tài liệu trống 
 c.Ctrl-T: chữ nghiêng    d. Ctrl-B : Chữ đậm 
83. Trong MS Word sau khi khối đoạn văn bản rồi bấm giữ chuột và kéo đi, kết quả là: 
 a.Xóa đoạn văn bản đó    b. Dời đoạn văn bản đó sang vị trí mới 
 c.Sao chép thêm đoạn văn bản mới  d.Không có tác dụng gì cả 
84. Trong MS Word sau khi khối đoạn văn bản rồi nhấn Ctrl-X thì: 
 a.Xóa đoạn văn bản đó   b. Dời đoạn văn bản đó sang vị trí mới 
 c.Sao chép thêm đoạn văn bản mới d.Xóa đoạn văn bản đó và lưu vào clipboad  
85. Trong MS Word để làm kí tự đặc biệt(Symbol) lớn lên thì: 
 a.Bấm chuột vào góc và kéo ra b. Khối kí tự rồi chọn cỡ chữ (Size) lớn 
 c.Không làm lớn lên được  d.Câu a và b đúng 
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CÂU HỎI EXCEL   
 

86. Các tập tin bảng tính Excel có phần kiểu (phần mở rộng) là : 
a. EXE, EXEX  b. DOC,DOCX 
c. DAT,DATX d. XLS, XLSX  

87. Trong MS Excel, để tạo mới bảng tính ta sử dụng tổ hợp phím: 
a. Ctrl-Shift-N. b. Ctrl-N.  
c. Ctrl-A. d. Ctrl-O. 

88. Trong MS Excel, để lưu thêm bảng tính với tên mới ta có thể : 
a. Sử dụng  tổ hợp phím Ctrl-S. b. Vào menu File\Save As….  
c. Sử dụng  tổ hợp phím Alt-S. d. Vào menu Edit\Save As….. 

89.Trong MS Excel để chọn vùng ô rời rạc: 
 a. Dùng chuột chọn trong khi giữ phím Shift. 
 b. Dùng chuột chọn trong khi giữ phím Alt. 
 c. Dùng chuột chọn trong khi giữ phím Ctrl. 
 d. Dùng phím Tab di chuyển và click chuột chọn. 
90.Trong MS Excel để chọn vùng ô liên tục: 
 a. Dùng chuột chọn trong khi giữ phím Shift. 
 b. Dùng chuột chọn trong khi giữ phím Alt. 
 c. Dùng chuột chọn trong khi giữ phím Ctrl. 
 d. Câu a, b,c đúng.  
91. Trong MS Excel chỉ có địa chỉ cột được thay đổi, còn địa chỉ dòng cố định khi ô chứa công thức 
được sao chép đến vị trí ô khác, thì gọi là địa chỉ gì? 

a. Địa chỉ tương đối. b. Địa chỉ tuyệt đối. 
c. Địa chỉ tương đối cột, tuyệt đối dòng.  d. Địa chỉ tuyệt đối cột, tương đối dòng. 

92. Trong MS Excel, để xoá hẳn 1 dòng khỏi bảng tính: 
a. Chọn dòng cần xoá rồi nhấn phím Delete.   
b. Chọn dòng cần xoá, click chuột phải rồi chọn Delete.  
c. Cách a và b đều đúng.  
d. Cách a và b đều sai. 

 
93. Trong MS Excel, thao tác xoá như hình vẽ sẽ: 

 
a. Xoá các ô được chọn và các ô dữ liệu tiếp giáp bên trái sẽ dời sang.   
b. Xoá các ô được chọn và các ô dữ liệu tiếp giáp bên phải sẽ dời sang.  
c. Xoá dòng hiện hành.  
d. Xoá cột hiện hành. 

 
94. Trong MS Excel, khi nhấn tổ hợp phím Ctrl-Home có nghĩa là 
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a. Chuyển về ô đầu tiên của bảng tính (ô A1).  b. Chuyển về ô cuối cùng của bảng tính 
c. Chuyển về ô đầu dòng.  d. Chuyển về ô cuối dòng. 

95. Trong MS Excel, khi nhấn phím Home có nghĩa là 
a. Chuyển về ô đầu tiên của bảng tính (ô A1).  b. Chuyển về ô cuối cùng của bảng tính 
c. Chuyển về ô đầu dòng. d. Chuyển về ô cuối dòng. 

96. Trong MS Windows, để định cách nhập ngày tháng trong phần mềm Excel, ta vào : 
a. Control Panel \ Add Hardware. b. Control Panel \ Date and Time. 
c. Control Panel \ Display. d. Control Panel \ Regional and Language. 

97. Trong công thức của Excel, để nhập toán tử luỹ thừa (số mũ) ta dùng : 
a. Tổ hợp phím Ctrl_Shift_=. b. Tổ hợp phím Ctrl_=. 
c. Phím ^ . d. Không có toán tử này.  

98. Công thức $A3+$B3 tại ô C2 khi được chép sang ô D2 sẽ có dạng là: 
a. A4 + B3 b. A3 + B4 
c. A3 + B3 d. $A3 + $B3      

99. Bốn loại toán tử mà Excel sử dụng là: 
a. Số học, chuỗi, so sánh, tham chiếu.  b. Số học, đại số, so sánh, tham chiếu. 
c. Số học, đại số, biểu đồ, so sánh. d. Đại số, chuỗi, biểu đồ, tham chiếu. 

100. Trong Excel, toán tử “%” là : 
a. Phép chia lấy số dư. b. Phép chia lấy phần nguyên. 
c. Phép toán “phần trăm”. d. Không có toán tử này. 

101. Trong Excel, cặp toán tử “<” “ >” liền kề nhau dạng “<>”là: 
a. Cho biết giá trị “nằm trong khoảng”. b. Toán tử so sánh “khác nhau”.  
c. Thay cho toán tử “=”. d. Không sử dụng được. 

102. Giả sử ô A1= -3,2. Công thức Int(A1. có giá trị là bao nhiêu? 
a. -4 b. -3 
c. -2 d. 3 

103. Trong Excel, để tính ô ThuếGTGT là 10% của ĐG (ĐG là giá trị hoặc địa chỉ của ô chứa giá trị 
Đơn Giá) ta nhập công thức sau: 

a. =10% * ĐG     b. =10/100 * ĐG     
c. =0.01 * ĐG     d. Cả a, b, c đều đúng . 

 
104. Cho bảng tính sau: 

 A B C D E 
1 Stt Mã hàng Số lượng Đơn giá Thành tiền 
2 1 H1 20 230  
3 2 H2 33 130  
4 …     

Công thức xác định giá trị cột thành tiền (Số lượng * Đơn giá) đặt ở ô E2 là: 
a. C$2*$D2     b. C$2*D$2     
c. C2*D2      d. $C$2*$D$2      

 
105. Biểu thức sau cho kết quả là gì  

= “abcde” - “cde” 
a. Báo lỗi   b. 2  
c.  3 d. “ab”  

106. Giả sử ô A1 có giá trị số là 2, ô A2 có giá trị số là 3. Biểu thức sau cho kết quả là gì ? 
= A1&A2 

a. Báo lỗi     b. 5  
c.  Giá trị số 23  d. Chuỗi ký tự “23”  
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107. Biểu thức sau cho kết quả là bao nhiêu?  
=Mod(8/3) 

a. 1     b. 2 
c. 3 d. Báo lỗi  

108. Biểu thức sau cho kết quả là bao nhiêu?  
=int(8/3) 

a. 1     b. 2  
c. 3 d. Báo lỗi  

109. Biểu thức sau cho kết quả là gì ? 
= “abc” + “cde” 

a. Báo lỗi    b. 6  
c.  “abccde” d. “abcde”  

110. Biểu thức sau cho kết quả là gì ? 
= int(-5/-3) 

a. 1     b. -1  
c.  2 d. -2  

 
111. Trong MS Excel, một cột có cả ô chứa giá trị số và ô chứa giá trị chuỗi. Khi ta sắp xếp dữ liệu 
với từ khoá Ascending thì dữ liệu trong cột sẽ được : 
 a. Sắp xếp tăng dần, thứ tự các giá trị chuỗi trước, số sau.  
 b. Sắp xếp tăng dần, thứ tự các giá trị số trước, chuỗi sau.  
 c. Chỉ sắp xếp tăng dần đối với ô kiểu số (Number). 
 d. Chỉ sắp xếp tăng dần đối với ô kiểu chuỗi (Text). 
112. Trong MS Excel, một cột có cả ô chứa giá trị số và ô chứa giá trị chuỗi. khi ta sắp xếp dữ liệu 
với từ khoá Descending thì thì dữ liệu trong cột sẽ được: 
 a. Sắp xếp giảm dần, thứ tự các giá trị chuỗi trước, số sau.  
 b. Sắp xếp giảm dần, thứ tự các giá trị số trước, chuỗi sau.  
 c. Chỉ sắp xếp giảm dần đối với ô kiểu số (Number). 
 d. Chỉ sắp xếp giảm dần đối với ô kiểu chuỗi (Text). 
113. Trong MS Excel ta có thể sắp xếp thứ tự với kiểu dữ liệu: 
 a. Kiểu Number. b. Kiểu Text 
 c. Kiểu Date/Time d. Không hạn chế kiểu dữ liệu 
114. Trong MS Excel, giả sử dữ liệu bảng tính có cột Số thứ tự (STT) để sắp xếp lại bảng tính mà 
không ảnh hưởng đến cột STT ta có thể : 
 a. Khối chọn phần dữ liệu cần sắp xếp trừ cột STT rồi thực hiện.  
 b. Khối chọn phần dữ liệu cần sắp xếp cả cột STT rồi thực hiện.  
 c. Không thể sắp xếp mà không ảnh hưởng đến cột STT.  
 d. Sắp xếp tuỳ ý mà không ảnh hưởng gì đến cột STT.  
115. Hàm có tên là SQRT trong Excel dùng để: 

a. Tính căn bậc hai.  b. Lấy phần dư của phép chia. 
c. Làm tròn số. d. Lấy giá trị tuyệt đối. 

116. Trong MS Excel , biểu thức  =Supper(“LonG An”) cho kết quả là: 
 a. “LONG AN”. b. “Long An”.   
 c. “ long an“.    d. Hiện thông báo lỗi.  
117. Trong MS Excel , biểu thức  =Lower(“LonG An”) cho kết quả là: 
 a. “LONG AN”. b. “Long An”.   
 c. “ long an“.    d. Hiện thông báo lỗi. 
118. Trong MS Excel , biểu thức  =Upper(“LonG An”) cho kết quả là: 
 a. “LONG AN”. b. “Long An”.   
 c. “ long an“ d. Hiện thông báo lỗi. 
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119. Trong MS Excel , biểu thức  =Proper(“LONG AN”) cho kết quả là: 
 a. “LONG AN”. b. “Long An”.   
 c. “ long an“ d. Hiện thông báo lỗi. 
120. Trong excel, để biết được ngày hiện tại trong hệ thống máy tính (không cần hiển thị giờ, phút, 
giây., ta sử dụng hàm nào trong các hàm có tên dưới đây 

a. Date b. Now   
c. Today    d. Year 

121. Trong MS Excel, cho biết giá trị của công thức sau đây: =MIN(MAX(“5”,2),7) 
a. 7  b. Công thức có lỗi  
c. 5     d. Câu a, b, c sai.  

122. Trong MS Excel, hàm có tên là ROUND dùng để: 
a. Lấy phần nguyên của số. b. Lấy phần dư của phép chia   
c. Làm tròn số. d. Câu a, b, c sai. 

123. Giả sử ô A1 có dữ liệu “TT GDTX TN”, để lấy chuỗi “GDTX” ta có thể dùng công thức: 
 a. =Mid(A1,2,4) b. =Mid(A1,3,4) 
 c. =Mid(A1,4,4)   d. =Mid(A1,4,3) 
124. Biểu thức sau cho kết quả là bao nhiêu: =YEAR("2005/06/05") 

a. #Name? b. 2005    
125. Trong MS Excel công thức =INT(13/6)+MOD(3,7) cho kết quả là : 

a. 3  b. 4 
c. 5.    d. Câu a, b, c sai. 

126. Trong Microsoft Excel chọn nhóm hàm chuỗi gồm: 
a. Left, Max, Min. b. Left, Right, Mid.   
c. Mid, Mod, Min. d. Value, Int, Round. 

127. Trong MS Excel, nhóm hàm cơ sở dữ liệu có tên là: 
a. Max, Count, Dcount. b. Countif, Sumif, Dmin. 
c. Dmax, Dmin, Dcount.  d. Câu a, b, c sai. 

128. Biểu thức sau cho kết quả là gì:         =Max(2,3,7,9,e) 
a. 2  b. 9 
c. #Name?     d. #Value! 

129. Trong Excel, biểu thức sau trả lại kết quả là gì:        =Sum(A1:A5) 
a. Tổng các số trong các ô A1, A2, A3, A4, A5     
b. Tổng 2 số trong ô A1 và A5 
c. #Name? 
d. #Value! 

130. Trong MS Excel, cho biết giá trị của công thức sau đây: =MIN(MAX(“5”,2)+7) 
a. 9  b. Công thức có lỗi  
c. 12    d. Câu a, b, c sai.  
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CÂU HỎI TRẮC NGHIỆM ÔN TẬP MS-POWERPOINT 
 
 
131. Trong MS PowerPoint, sau khi đã thiết kế xong bài trình diễn, cách làm nào sau đây không phải 
để trình chiếu ngay bài trình diễn đó? 

a. Chọn Slide Show -> Custom Show  b. Chọn Slide Show -> View Show 
c. Chọn View -> Slide Show    d. Nhấn phím F5 

 
132. Trong MS PowerPoint. Đang trình chiếu một bài trình diễn, muốn dừng trình diễn ta nhấn phím 

a. Tab       b. Esc  
c. Home      d. End 

 
133. Trong MS PowerPoint . Thao tác chọn File -> Open là để  

a. Mở một presentation đã có trên đĩa   
b. Tạo mới một presentation để thiết kế bài trình diễn 
c. Lưu lại presentation đang thiết kế 
d. Lưu lại presentation đang thiết kế với một tên khác 

 
134. Trong khi thiết kế giáo án điện tử, thực hiện thao tác chọn Insert -> New Slide là để 

a. Chèn thêm một slide mới vào ngay trước slide hiện hành 
b. Chèn thêm một slide mới vào ngay sau slide hiện hành 
c. Chèn thêm một slide mới vào ngay trước slide đầu tiên 

 d. Chèn thêm một slide mới vào ngay sau slide cuối cùng 
 
135. Trong MS PowerPoint, để tạo một slide giống hệt như slide hiện hành mà không phải thiết kế 
lại, người sử dụng 
 a. Chọn Insert -> Duplicate    b. Chọn Insert -> New Slide 
 c. Chọn Insert -> Duplicate Slide   d. Không thực hiện được 
 
136. MS PowerPoint, thao tác chọn Delete Slide là để 
 a. Xóa slide hiện hành   
 b. Xóa tập tin có nội dung là bài trình diễn hiện hành 
 c. Xóa tất cả các slide trong bài trình diễn đang thiết kế 
 d. Xóa tất cả các đối tượng trong slide hiện hành 
 
137. Trong MS PowerPoint , để thực hiện việc chèn bảng biểu vào slide ta phải 
 a. Chọn Table -> Insert Table    b. Chọn Table -> Insert 
 c. Chọn Insert -> Table    d. Chọn Format -> Table 
138. Trong MS PowerPoint. Thực hiện thao tác liên quan Animation là để 
 a. Tạo hiệu ứng động cho một đối tượng trong slide 
 b. Tạo hiệu ứng chuyển trang cho các slide trong bài trình diễn  
 c. Đưa hình ảnh hoặc âm thanh vào bài trình diễn 
 d. Định dạng cách bố trí các khối văn bản, hình ảnh, đồ thị ... cho một slide 
 
139. Khi đang trình chiếu (Slide Show) một bài trình diễn, muốn chuyển sang màn hình của một  
chương trình ứng dụng khác (đã mở trước) để minh họa mà không kết thúc việc trình chiếu, ta phải 
 a. Nhấn tổ hợp phím Ctrl + Tab   b. Nhấn tổ hợp phím Shift + Tab 
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 c. Nhấn tổ hợp phím Alt + Tab   d. Nhấn tổ hợp phím Esc + Tab 
 
140. Trong MS PowerPoint Chọn phát biểu sai: 
 a. Khi tạo hiệu ứng động cho một khối văn bản ta có thể cho xuất hiện lần lượt từng từ trong 
khối văn bản khi trình chiếu 
 b. Sau khi đã tạo hiệu ứng động cho một đối tượng nào đó ta không thể thay đổi kiểu hiệu ứng 
cho đối tượng đó 
 c. Có thể thực hiện hiệu ứng chuyển trang cho 1 slide bất kỳ trong bài trình diễn 
 d. Có thể thực hiện hiệu ứng chuyển trang cho tất cả các slide trong bài trình diễn 
141. Trong MS PowerPoint . Âm thanh đưa vào bài trình diễn  
 a. Thực hiện được chỉ khi tạo hiệu ứng động cho đối tượng trong slide. 
 b. Thực hiện được chỉ khi tạo hiệu ứng chuyển trang giữa các slide. 
 c. Thực hiện được cả khi tạo hiệu ứng động và hiệu ứng chuyển trang. 
 d. Không thực hiện được cả khi tạo hiệu ứng động và hiệu ứng chuyển trang. 
. 
142. Trong MS PowerPoint, để các slide đều có tên tác giả khi trình chiếu ở Footer, ta thực hiện tổ 
hợp phím nào sau đây?  
A.  ALT+V+A B.  ALT+I+W C.  ALT+V+H D.  ALT+I+I 
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TRẮC NGHIỆM PHẦN MẠNG & INTERNET 
 

143. Chọn phát biểu sai: 
a. Mỗi máy tính tham gia vào mạng phải có địa chỉ duy nhất, được gọi là địa chỉ IP. 
b. Người dùng làm việc với địa chỉ IP cả dạng số và dạng kí tự 
c. Máy làm việc với địa chỉ IP dạng số còn người dùng chỉ làm việc với địa chỉ IP dạng kí tự. 
d. Địa chỉ IP dạng kí tự (tên miền) có thể gồm nhiều trường cách nhau bởi dấu chấm. 

144. Để đăng kí hộp thư điện tử người dùng có thể sử dụng nhà cung cấp dịch vụ: 
a. GMAIL     b. HOTMAIL 
c. YAHOO     d. Các câu trên đều đúng 

145. Chọn phát biểu chính xác nhất về mạng Internet? 
a. Là mạng của các mạng, có quy mô toàn cầu 
b. Là mạng sử dụng chung cho mọi người, có rất nhiều dữ liệu phong phú 
c. Là mạng có quy mô toàn cầu hoạt động dựa trên giao thức TCP/IP 
d. Là môi trường truyền thông toàn cầu dựa trên kĩ thuật máy tính. 

 
146. WWW là viết tắt của cụm từ nào sau đây? 

a. World Wired Web   b. World Wide Web 
c. World Wide Wed   d. Windows Wide Web 

 
147. Phát biểu nào về website dưới đây là phù hợp nhất? 

a. Là một máy chủ cung cấp dịch vụ web 
b. Là một trang chủ 
c. Là một hoặc nhiều trang web được tổ chức dưới một địa chỉ truy cập 
d. Là một hoặc nhiều trang web của cùng một tổ chức 

 
148. Phát biểu nào dưới đây về trang web tĩnh là chính xác nhất? 

a. Là trang web chỉ chứa nội dung văn bản 
b. Là trang web không chứa hình ảnh động như đoạn phim video 
c. Là trang web không có khả năng tương tác với người dùng 
d. Là trang web không cung cấp chức năng tìm kiếm 

 
149. Trang chủ (Homepage) là: 

a. Trang web hướng dẫn sử dụng website  
b. Trang web đầu tiên được mở ra khi truy cập website đó 
c. Trang web của cá nhân    
d. Trang web mà người dùng đang nhìn thấy. 
 

150. Trong một hệ thống mạng nội bộ ngang hàng (Local Network) sử sụng hệ điều hành Windows 
(XP) để dùng chung một máy in thì: 

a. Tất cả các máy tính trong mạng phải được cài đặt trình điều khiển thiết bị (Driver) cho máy 
in đó.  

b. Máy tính kết nối trực tiếp với máy in phải được cài đặt trình điều khiển thiết bị (Driver) cho 
máy in đó 

c. Máy in phải được chia sẻ (Share) quyền truy cập.    
d. Cả 2 ý: b và c. 

 
HẾT 




